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1 INTRODUCTION

GENIUS is the first Touch&Map tool allowing the serial reading and programming of the memory of the
ECU (electronic control unit) managing the vehicle engine.

Its STAND ALONE conception and its TOUCHSCREEN panel make it a unique tool. Being an
INDEPENDENT tool, Genius does not need to be connected to a PC during the reading and the
programming procedures, thus avoiding dangerous blocks or slowdowns caused by the multitasking
operative system of the PC. Moreover it is a particular easy and user-friendly tool thanks to its practical
TOUCHSCREEN panel.

To grant the highest standards of safety, GENIUS is equipped with a battery which — should an
accidental disconnection from the OBDII socket happen during programming — allows to easily restore
the communication with the ECU, as all the DIMSPORT-branded serial programming protocols grant.
This new revolutionary tool supports CAN systems , too, other than K LINE, L LINE, and J1850.
Genius has a big memory capacity, supplied by a removable 256 Mbyte SD CARD (SECURE
DIGITAL), which can be expanded up to 1 Ghyte.

2 TECHNICAL SPECS

LCD 320 x 240 pixel DISPLAY, CCFL backlight, transflective TOUCHSCREEN with Touch Panel
512KByte PROTECTED FLASH MICROPROCESSOR MEMORY

16MByte RAM MEMORY

FILE ARCHIVE MEMORY IN 256 MByte SECURE DIGITAL expandable up to 1Gbyte

ALERT LED for SECURE DIGITAL, USB, POWER SUPPLY, DIAGNOSTIC LINE

Internal CLOCK with memory and and 3 volt Lithium battery

8.4 volt 600 mAh RECHARGEABLE internal battery

12 volts to 30 volts POWER SUPPLY TENSION

COMMUNICATION LINES with diagnostic port K LINE, L LINE, CAN2.0, J1850

USB CONNECTION TO PC
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3 GENIUS BAG KIT

The GENIUS BAG includes all the components for the serial programming that are given to the
customer when purchasing Genius.
Here below you find the list of all components with its code

RIF. | CODE DESCRIPTION

1 F32GENIUS Genius — main device

2 F32GNO008 Genius — Obd cable (K-CANBUS- J1850)

3 C32GNALIM12 | 12volt 110/240V PSU with international plug

4 F32GN002 Genius — Adaptor for compatibility with the old system FLASH 4
5 C32GNPEN Genius — n.3 Pens for the TOUCH PANEL

6 C32GNUSBO01 Genius — USB cable for PC connection

7 F32GNO011 Universal wiring for serial programming

8 F32GNO003 Genius — Wire to connect to the battery

9 C32GNVAL Genius — Bag (picture of the full kit)
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OPTIONAL
RIF. | CODE DESCRIPTION
10 F32ALIM12V PSU 12V SW for VAG TDI cable
11 F32CBATT +12V battery cable for VAG TDI cable
12 F32FLOO3P OBDII wire for PORSCHE M5.2.2
13 F32FL005 Race plug for VAG TDI ECU
14 F32FL002 BMW diagnostic connector + RJ45 wire’s adaptor for BMWIload
15 F32FL004 Mercedes diagnostic connector
16 F32FL001 FIAT ALFA LANCIA diagnostic connector for serial communication
17 F32FL006 A cables for Bosch ME7.3.1, ME3.1, ME2.1, ME7.3H4 hybrid ECU
18 F32FLO07 B cables for Bosch ME7.3.1, ME3.1, ME2.1, ME7.3H4 hybrid ECU

OPTIONAL CABLES 2008

RIF. | CODICE DESCRIZIONE

10 F32ALIM12V PSU 12V SW for VAG TDI cable

11 F32CBATT +12V battery cable for VAG TDI cable

14 F32FL002 BMW diagnostic connector + RJ45 wire’s adaptor for BMWIload

20 F32GNO013 OBDII wire for PORSCHE M5.2.2

21 F32GN015 Race plug cable for VAG TDI ECU

22 F32GNO014 Mercedes diagnostic connector cable

23 F32GN023 FIAT ALFA LANCIA diagnostic connector for serial communication
24 F32GN021 A cables for Bosch ME7.3.1, ME3.1, ME2.1, ME7.3H4 hybrid ECU
25 F32GN022 B cables for Bosch ME7.3.1, ME3.1, ME2.1, ME7.3H4 hybrid ECU
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4 CONNECTIONS, PORTS AND LED

Front Side

A) 1 USB port
B) 1 slot for SD Secure Digital card

C) 1 green LED for SD: it is on and still when the SD card is plugged in
It blinks when file are being saved on the SD card
D) 1 green LED for USB: it blinks when Genius is communicating with Race EVO

Back Side

E) 1 Diagnostic Port to plug the OBD cable or the universal wire for serial connection
F) 1 DC IN connector to connect to the 12 Volt 110/240 V PSU

G) 1 green LED “data transfer”: NOT YET FUNCTIONING

H) 1 red LED for ext power: it's ON when Genius is powered

Bottom Side

) 1 RESET button (to be used ony upon request of the technical support— i.e Genius is not
responding -)

L) 1 button to open the SD reader (to be opened and removed ony upon request of the technical
support: with a tipped tool carefully press the hole marked in the picture below as far as the cover is
open. To remove the SD card press slightly the card as far as there is a click, then release the card.

Dimensione Sport sr.l.
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The bottom part of Genius is equipped with:

M) 4 anti slide rubbers

N) 1 removable hand grip to hold Genius while working

5 HARDWARE REQUIREMENTS

e RaceEVO, (always updated in manu Update --> Race Update)

e 1 USB port

e Operating System Windows 2000 or XP

6 DRIVER INSTALL

After plugging for the first time Genius to the PC it is necessary to follow the procedure below:

1) Select “Yes, this time only " and click Next

Found New Hardware Wizard

Welcome to the Found New Hardware
Wizard

Windows will search for current and updated software by looking an
wour computer. an the hardware installation CD. or on the Windows
Update Web site (with your permission).

Bead our privacy policy

Can Windows connect to Windows Update to search for software?
@1ves, this time anly

(O)es. now and gvery time | connect a device
(Mo, notthis time

Click Next to continue.

MNext > l i Cancel

Dimensione Sport sr.l.
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2) Select “Install the software automatically (Recommended) " and click Next.

Found New Hardware Wizard

This wizard helps you install softwars for:

DimSport - Periferica Genius

\) If your hardware came with an installation CD or
- floppy disk. insert it now.

YWhat do you want the wizard to do?

®install the softwars automatically (Recormmended)

() Install from a list o gpecific location (Advanced)

Click Mextto continue.

’ < Back ” MNext > l [ Cancel

3) Click on “Continue Anyway " and then “Finish ”.

Hardware Installation

! E The software you are installing for this hardware:

Found New Hardware Wizard

Completing the Found New Hardware
Wizard

DimSpornt - Periferica Genius The wizard has finished installing the sofware for:

@ DimSport - Periferica Genius

has not passed Windows Logo testing to verify its compatibility with
Windows ¥P. (Tell rme why this testing is important )

Continuing your installation of this software may impair or
destabilize the correct operation of your system either
immediately or in the future. Microsoft strongly recommends
that you stop this installation now and contact the hardware
wvendor for software that has passed Windows Logo testing.

Click Finish to close the wizard

Continue Anyway || STOR Installation

Note
If you are using both devices 555Pro and Genius on the same PC, only after the first connection of
555Pro to PC you have to repeat the procedure of driver install for Genius.

7 BASIC TASKS

Once you got Genius the first operation you must accomplish is to leave it on charge 12h. this operation

must be repeated once a month.
It is possibile to recharge Genius after each modification connecting it to the PSU 12volt.

This procedure is necessary to charge completely the internal battery (8.4volt da 600 mah), this battery is
necessary for the data recovery after the loss of communication with the ECU.

Dimensione Sport sr.l. 11
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8 MAIN MENU

The first screen will show us:

a) main menu
b) information bar with voltage, date and time

Main menu has four buttons WORK, TOOLS, INFO, STANDBY that leed to the most important sections of
work and information:

- WORK to work

- TOOLS to visualise files, Genius settings and test

- INFO to get information about Geius and its protocols
- STANDBY to set Genius in standby mode

To get details about each single process please see the related chapters.

WORK

WORK button gives acces to main work session,

through a second level menu Genius allows to manage the
IDentification (Chpt. 9.1 Pg. 11), READING (Chpt. 9.2 Pg. 13)
and WRITING (Chpt. 9.3 Pg. 14).

TOOLS

TOOLS button gives access to the functions of visualisation of files loaded on the memory SD through the
EXPLORE SD (Chpt. 10.2 Pg. 20). It is also possible to modulate the settings of display, language, date and
time of Genius thanks to SETUP menu (Chpt. 10.1 Pg. 18); and run functional TEST (Chpt. 10.3 Pg. 21) on
differents components like Ram, Display, Led and Battery.

INFO
INFO function gives all the information about Genius, Protocols and Features.
(Chpt. 11 Pg. 21).

STANDBY
Once selected STANDBY button Genius goes into sleeping mode.
To wake up Genius touch display once (Chpt. 12 Pg. 23).

Dimensione Sport sr.l. 12
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9 WORK MENU

This menu gives access to main work session through some second-level menu that will lead to the
processes of IDentification, READING and WRITING.

9.1ECUID

This operation allows the identification of the electronic unit, after that it will be possibile get the
information necessary to download the correct setting file. To perform the IDdentification is possibile to
follow two different ways that have the same result:
A)
1. Follow the path and choose the correct selection

Work - Vehicles »>Manufacturer/Model/Type ->Protocol

2. Now the opening of the protocol will permit the IDentfication of the ECU.

Dimensione Sport sr.l. 13
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3. After the selection of ID Genius will ask to switch on and off the dash-board and ECU information will
be displayed, it is possibile to save all the information of the ECU.

To get once again the information of the Identification just finished it is necessary open the file saved
inside the ID folder following Tools=> Explore SD-> ID folder.
See Chpt.10.2 Pg. 20

After this operation we know the ECU identification data and it is possibile to search for the correct
setting file inside Race database

B)

Follow the path suggested and select the correct protocol to use:

Work = Protocols

Dimensione Sport sir.l. 14
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9.2 Serial reading

To get access to the Serial Reading it is necessary to follow the path below and choose the correct
selection depending on the vehicle Work > Vehicle > Manufacturer/Model/Type - Protocol
Otherwise follow the path Work > Protocols but you must know which protocol is required

NOTE

Each time Genius reads the ECU it creates a file with HEADER.

For details see Chpt.9.3 Pg.15.

At the end of the reading it is necessary to load the read file into the PC.
For this operation follow the instructions at Chpt 13.2.1 Pg.26.

Once the protocol is opened it will be possibile to select Reading

1. Click on Raeding

2. After the visualisation of ID Genius will ask to switch on and off the dash-board (this procedure is
required to verify the data).The reading progress bar will be displayed. After the reading we will have the
file that is inside the ECU of the vehicle.

At the end of the reading it will be possibile
the saving of the file inside Genius.

Dimensione Sport sr.l. 15
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9.3 Serial Writing

After the modification it will be possibile to load the modified file inside the ECU of the vehicle.

To get access to the Serial Writing process it is necessary to follow the path and choose the correct
selection depending on the vehicle Work > Vehicle > Manufacturer/Model/Type - Protocol
Otherwise following the path Work - Protocols but you must know which protocol is required.

Once the protocol is opened it will be possibile to select Writing

1. After selecting Writing Genius will show the folder Write with all the file modified or original that have

been written or will be written inside ECU.
Then select the file to write and follow the procedure.

After selecting the file to write follow the procedure, in some cases Genius will ask to switch on and

off the dash-board, it depends on the vehice.

Dimensione Sport sr.l.
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2. Once started the procedure ECU identification numbers will be read again.

If the data displayed don’t match with the hardware or software numbers click cancel and repeat the
procedure chosing the correct file.

If the data match proceed clicking on " OK ".

N.B. .

Each time Genius reads an ECU it creates a file with HEADER, it is a file caracterised by all the
identification data (Manufacturer/Model/Type, date and time, protocol used etc.etc). this kind of code is
recognised by Race EVO also during the creation of the modified file. With this type of code Genius
won'’t have any doubt before the writing of the file.

If a file without HEADER is going to be written inside the ECU Genius will ask ( to protect the ECU) if the
file chosen is the correct one.

For more details on how extract the HEADER from the file see Chpt.13.2.1 Pg.28.

If the programming is confirmed it is possibile to control
the programming procedure.

During this procedure do not perform any action on the vehicle or on Genius!!!

3. After programmig a message window will confirm the end of the procedure.
Switch off the dash-board and click on OK.

NOW THE ECU PROGRAMMING IS TERMINATED!

Dimensione Sport sr.l. 17
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9.4 Diagnosis

In some serial protocols it is available the deleting errors function. After serial programming in some
ECU might happen ( it might not happen) that some check lights in the dash-board light on.

For this reason only on some serial protocols , like for example on the FLASH_0082 for ECU VAG

ME7.1.1, the deleting error function has been introduced.

1 — open protocol FLASH that has the deleting error procedure in this way

Work->Vehicles=>select the correct vehicle

Work—> Protocols—> select the protocol FLASH with the deleting error procedure

Select the button DIAGNOSIS and run the deleting procedure clicking on the button DEL ERRORS

After it will be necessary to follow the procedure required by Genius, switch on the dash-board, a window
with the processing bar will open then at the end of the procedure of errors deleting a message will ask

to switch off the dash-board.

9.5 Index

Once inside the Protocols window at the bottom there is the tool bar with two buttons “Information” and

the “Screwdriver”.

Dimensione Sport sir.l.
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This button allow the visualisation of all the
information about the selected protocol, it shows the
kind of line used by the protocol to communicate
with the ECU.

Screwdriver

This button open the Setup K-line window about the selected serial Protocaol, it gives the opportunity to
modulate the transmission on the K-line.

NOTE

To manage these options it is strictly recommended the help of the technical support.

PULL UP

Selecting the “Screwdriver” and after the option Pull Up it is possibile to set the resistance of the serial
protocol. It is possibile check the resistance enabled on Genius, and verify the ch’ange, on status bar
(Es.Flash53).

Dimensione Sport sr.l. 19
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SPEED

Selecting the “Screwdriver” and after Speed it is possibile to modify the communication speed of the
serial protocol. It is possibile check the resistance enabled on Genius, and verify the ch’ange, on status
bar (Es.Flash53).

10 TOOLS MENU

10.1 Setup

Menu Setup manage the Genius settings, it allows the setting of the screen, language, date and time.

Display
In this section it is possible to calibrate and modify the settings of the Genius display:
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Touch Panel : it enables the calibrating of the Touch Panel. The procedure ask to touch with the pen the
four corners, suggested by the square, of the Touch Screen.

T~

Brightness : it allows to choose the display brightness timing before it goes in standby.

Contrast :it allows to increase or decrease the screen contrast.

Language
In the section Language it is possible to select
the language for the Genius. -

Dimensione Sport sr.l. 21
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Date and Time
In the section Date and Time it is possibile
to modify day, month, year and date of Genius.

10.2 Explore SD

Explore SD allows to check what files are stored inside the SecurDigital, they are inside the three
different folders of the main functions of Genius.

- Folder ID has all the IDentification files saved
- Folder Read has all the Reading files saved
- Folder Write has all the files loaded that have to be written in the ECU

N.B.

Once inside one of these three folders it is possibile to check all the information of a single file. In this
way it is possible to verify the HEADER of the files created, checking if the file we are going to use is
correct.

Dimensione Sport sr.l. 22
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10.3 Test

Test Menu allows to test different components of Genius in order to verify their status and functionality
With this tool it is possible to verify Ram, Display, Led and Internal Battery of Genius.

B =

In Tools=>Test menu two different kinds of Ram test are available, Ram Test2 is a more detailed and
deep analysis to run only after the request of the technical suport.

Following the instructions of the Ram test of Genius it is possibile to check the execution and final resullt,
after the Test Genius will ask to reset the system.

11 INFO MENU

Through this Menu it is possibile to verify the presence and functionality of Protocols, identity data and
features of Genius.
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11.1 Protocols

Protocols section allows to check each single Serial Protocol, after selecting a Protocol and following the
instructions it will be possibile to read all the data of the selected protocol.

In the Protocol list, left side, it is shown the protocol status:

— » Protocol missing in Genius

» Protocol not updated for the Genius version
In this case update Genius directly from the software
See Pg. 30
——» Protocol working

11.2 Info Genius

This function visualise all hardware and software informations of Genius.

Dimensione Sport sr.l. 24
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11.3 Features

Selecting Features we will be able to check the Features Options enabled, how many Serial Points for
programming are still inside and what contract is enabled on Genius.

12 STANDBY

Selecting STANDBY it enables the sleeping modality.
To wake up Genius just touch the screen.
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13 PC CONNECTION

13.1 Hardware connection

To connect Genius to PC read the following instructions:

1 — Tthe power supply must be correctly set on the 12V
Regulated
DOIN e
KS1250 Power Supply

INPUT : 100 - 240 V~ 50/80 Hz 20W
OUTPUT :3-4.5-8-7.6-8-12V 227 1200 mA
14.4 VA (Max.)

POLARITY: 881 the arrow of the plug and sackst & the same
taca, Then il ting tha cerract poarity shown on the face

1 he plug,
ol the plug, :‘:?_V’::)... o)

3 — Connect USB cable to Genius.

4 — Connect USB cable to PC.

Dimensione Sport sr.l.
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13.2 Software connection

After the connections to power and USB it is possibile to start the software communication between

Genius and Race EVO. In order to run correctly this operation Genius must be set in main menu. After
the connection with Race EVO Genus will show the message of USB comunication.

. Flle Miew Emulator Toals |_'§§|:Liu5~|l-_l_pr:|a|:a Help

B D)@ 55| e »

File for kechrical support 4

File I

Explare. .,

EXPLORE

To explore SD memory and work directly from Race EVO with the files read out by Genius click on
Genius~>Explore. SD memory directory and a work toolbar will open to allow the customer to work

and manage the files stored inside Genius.

ADVISE:

It is suggested to work only with the files coming from an IDentification, a Reading or a Writing saved

inside the folder File.

Enter inside the others folders only if requested by the technical staff.

: File  iew Genius Help

(e B @@ & § | B TF §R | o
e (MEBE N

|4 = N. % |0y ® | B

ST Geniusif

@ﬁﬂ@mkﬁ@@@

Marme

Aktributes
Direckary
Direckary
Directaory
Direckary
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13.2.1 Join/Export file

To export files of ECU inside Race EVO and manage the modifications it is necessary to know the
identification numbers of the ECU and download the correct setting file.

Once inside Race EVO open the corresponding setting file, it is possible to import the file read out
with Genius with the button Genius , this button allows to Import image from Genius

[ \ Jain New Image ] Save ta: |fF\|efH_ead |
[ N\W File for EPROM ] MHame Atri.. | Dimension | Modfy date 2~
e et A .ORl File ... E12KB 2340142007 10.23
A7 ORI File-... 255 KB 0141242006 11,49
[ ge\@ Wiiting ] Iy HOD Fle..  B4KE  28/01/2007 1548
- - L;S] ORI File ... 240KB 11012007 1233
[ 5 enal\ﬁeadmg ] Al oRl File: 256 KB 01/12/2006 1512 J
A MOD File.... 1ME 18410/200617.16
I ORI Fie-... 1ME 1041042005 19,42
| Genius @ .ORI File ... THE KB 12/09/200619.14
= R File B4KE 081022005 16 27
Write image to Gerius S File:... 1ME 121242006 15,54
)fﬂ ORI File ... E4KE 04/01/2007 1658«
Import image Frarm Genius £ i ]
File name: | Rl v| [ Open
Cancel ] [ <Back J Of

Select the file from the folder Read of Genius and save it inside the corresponding setting file
selecting if it is an original or and already modified file.

Eprom image description

.D ezcription
Join Image |Bancab1| | L
OR| inl Il
- Mumber plate
%) Original | |
© Modity Chassiz
D bl file | |
Mates
2] Race EVO PLUS

i Fle  Wew Emulator  Tools  Genius  Update  Help

R [P @ 5 |5 | # | BT TR | o

M Sclect Eprom image

Selected car LANCIA YPSILON 1.3 L 168 MULTIJET ECU:1064Y152

Dimension Humber plate

Description [ Type [ Data Checksum CHE161
LAHCAS0D.ORI | 1 2004/2006 14:55:55 As0D

1200472006 14:55:57 ABCE

Now it is possibile to load the file read from the vehicle and manage the modifications required.
For more informations about how to modify a file fo llow the instructions af Race Manual.
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After modifications and saving of the file it is necessary to export the file on Genius, then select the
desired file to export and click on the button Genius .

4
File  View Emulster  Took  Gemus  Lpdste  Help
,33: @ ||,,|| F ||| EL | @ (B 2 TF FF 5100 | ok
e~ e - T Sag ||| == N, 3 | O

Selected can  LAMCIAYPSILOM 1.3 L 18V MULTIJET ECLL 1064Y 152

Description i Type ] Dhata ! Check sum CHHAGI [nlmanllnnl
LAICASID.0R L B 120aE00814sSESs | ASOD | BFOd 353k
(7 i_“&{G'J an.-tpﬁ‘l : 1] 27411 2008 181632 | S387 I 'ME_Q 512 Kbi

1200202005 14:58:57 DBE? 353 dlsi

LA ASOD ABCE

< MY 00 222 S22 KhH

From the Genius button select Write image to Genius, be sure that the file .MOD is saved with
name inside the folder “Write”.

- [ iSave eprom file
[ Join Mew Image ”
| MewFiefor EPROM /| Findta  [Fisrwite / | | |
Fiestore rom Emulator Mame ..t'-‘lttn. [Dimension | Madify date
|
[ Seiawiiting._ | A MOD 128K 15/02/200712.23
Al Mop S12KB 2300172007 1156
| SeialReadng | | A moD DREKE  (N/12/2008 12,27
Al oAl 1MB 24/10/2006 19.20
A OR ZEKE 01/12/200615.40
Genius A MoD 1MB 18/10/2006 17.10
o _ Al oRl 1MB 10/10/2006 19,56
[t mans e % Al mMop 7EGKE  12/09/200619.15
Import image from Genius &) R BAKE  DBADZOOGTRET
Al MOD 1MB 12A2/2008 1658 =
4 | »
Cancel J [ <Back J File name: | MOD | S_a_vE_ |
.tfanu:e'l I

In order to be sure that the selected file has been correctly saved o Genius open the connection
through the function Explore, open the folder File and check if inside the folder “Write” there is the file
.MOD just imported.

File  Miew Emulator  Tools |§Eﬂ|u5| Idpdate  Help
E Y| 9@ VS| | Undate K
- File For technical support » __ N fﬁ | B & | @

File IC...

Explore...

Now exit from the software connection with the PC and unplug all the hardware connections. Enter in
the vehicle with Genius and follow the instructions for the Serial Writing Chpt. 9.3 Pg. 13
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It is possible to export or import file from Genius following another way that allows to work with files
also outside Race EVO.

To export ECU files inside Race EVO it is necessary a double click on Explore and click on File
folder, there are present the files saved inside ID,Read, Write folders.

: | File Wiew Gemius 7 | File  wiew Genius Help
i S N g (s i RIT NI BT S A
e, l' i A cHiy, e e e N L ARy B
2 A SR : 7| oy e
2 ne e - [y

ar

N : Genius:IIFiIeIR@

JORI
JORI
ORI
MOD
JORI
JORI
MO
JORI
ORI
ORI
ORI
JORI

S Genius:File

Mame

I cad
I=d
e |

12 Write %

ORI

Once inside Read folder we will have the possibility to choose which file export.

Follow the procedure: | @ '
o select the chosen file X
click on the button Save file onthe Toolbar %

0
o save the file, default folder is Upload
0 choose to extract or not HEADER (YES / NO)

Race VO X

“?fj Extract header?

5 I w

DON'T EXTRACT: the file of the vehicle with HEADER will be saved inside the folder. Following this
procedure during the writing of the modified file inside ECU the Genius will know that the chosen file
is correct for the ECU because the Genius will read the HEADER.

EXTRACT: the file of the vehicle without HEADER will be saved inside the folder and it can be
exported out of the Race. Inside the folder will be saved also the HEADER in *.txt with inside all the
instructions about the file read. Following this procedure during the writing of the modified file inside
ECU the Genius will ask to confirm if the file that we are writing is correct because inside the file
Genius won't find the HEADER.

Now it is possibile to manage the file read out wit ~ h Genius inside or outside Race EVO.
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To import files inside Genius it is necessary to connect Genius and select the btutton Explore, open folder
File=>Write and click on the button Import File .

Select the file to import and click OK. \ il

: 77 File  view iGenius.  Help

h T Y A A

‘T Bl ¥iew Genius 2

=0 A A Pk

-

© T Genius:/iFile

Mome
I Cod
=1d
' Read

Wrike

oD
JTriod
JORI

13.2.2 File for the Technical Support

The customer has to export the file for the technical Support from Genius in two different cases:

1) correct ECU setting file missing in databank
2) technical support requires the sending of Log files

1) DS File

If after the reading of the file the related setting file is not present in the Dimsport databank the file
cannot be loaded and opened in Race, but the DS file can be sent to the Technical Support.

This DS file will let the Technical Support to create a specific setting file for that ECU; after the
downloading of the specific setting file inside Race EVO the customer will be able to proceed with
modifications.

Follow the procedure:

- click on file for Support-> File DS
- select the correct file to send

i Flle  iew Emulator  Tools |§er|il_,|s_ ] pdate Helg
.= N S NCART

-

pdate 4 |H|f.

File For technical support L4 Save Log file. .. | By

File ID... File: D5 ..

Explore. ..
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2) Log file
Send these kind of files only after the request of the Technical Support, they need them to help the
customer during particolar or problematic situation.

Follow the procedure:
- click on file for Support-> File Log
- select the files required for the Techncal Support

: File Wiew Emulstor Tools | Genius | Update  Help

: e | P Update k HE
B a9 |
« [ o | Eile For technical support k Save Log file. .. | By

| File 10, File: D5 ..

| Explore...

13.2.3 Update

Update function allow to run several updates for the Genius tool.

- Protocols Features
- System Version
- GOS Recovery

: File Miew Emulakor  Tools |-£F-__.ni|_J:-:-_,_ Ipdate  Help

o I A | e
: o 4 | Eile faor technical support k Syskem ¥ @ |

| File I, ..

| Explore...

Protocols features
Clicking on Load ABL it is possibile to import the ABL file with the protocols features that the
customer has to enable on Genius.

System Version

After the connection of the PC to Internet the Update System function allows the updating of the
Genius Operative System. It is suggested to periodically run the Automatic update of the GOS
version in order to have always the last release available.

: Fle  Wiew Emulator  Tools | Genius | Update  Help
i a5 | Update b Lead ABL...

| File for technical support k| Swskem L4 Automatic, ..

-]

-

File 1D, Forced. ..

Explore...
GOS recovery. .,

Selecting Automatic Race EVO will verify and compare the versions of all the files of the GOS
loaded on Genius with the last versions available. If there are some updates available they will be
downloaded and automatically installed on Genius.

Selecting Forced Race EVO will run the download of the last release of GOS available and will
perform the installation without comparing.
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GOS Recovery
The function of GOS Recovery must be done only after the request of the Technical Support.

It is necessary to run the GOS Restoring after an interruption of data transfer during the Updating of
the GOS and Genius lose all the necessary information to run correctly the system.
Please contact the Technical Support if this problem happens.

13.2.4 File ID

Clicking on the button File ID is possible to visualise all the Identifications done and saved on
Genius. This option allows to see on the screen all the info of the file in order to find out on the
databank the corresponding setting file.

: File Miew Emulator Tools |§|_aniu__5 pdate  Help

= A A AR

IIpdate P IHK

- Eile Far technical support Pl - N - NS SN

File IC. .. %

Explore...

+ 1D File Genius
Mame | Ah.. | Dimension | Modifydate 4 el |
Fil... 201B 1900212007 11.52 o
E\j Fil... 189E 26012007 15.17 ﬂl
:E‘\_j Fil... 2038 11/01/2007 12.29
L‘;“j Fil... 204 B 18/10/2006 17.07
.fﬂ Fil... 179E 10/10/2006 16,30
L-fl:] Fil... 2228 12/12/2006 15.45 |
@ Fil... Z3ZB 12/0z2/2007 158.21
[ Fil... 241 B 2001042006 11.54
iéj Fil... 2238 11/12/2006 14.58
rﬁ.‘. Fil 187 R 10M 0 2nne 18 12 fud
o | _l"
File bformation O
é] Following information are about the Fle-BWET LN
Type hile 18]
Protocol name FLASH 0055
Protocol version 1.000
File date 110142007
File time 122844
Manufacturer REMALILT
Mndel CLICLE
Tvpe 15 L dcigsHP
Protocol FLASH_ 0055 REMMISS DELPHI 1 5 DDC
Hardware number
Software number

LS
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13.2.5 Genius Info and protocols

Under the “Help” of Race main menu there is Genius Setting option, clicking on this option with the
Genius connected to the USB port of PC and to Power Pack it is possible to check all the features
enabled on Genius.

! File Miew Emulator  Tools  Genius  Update |}jplp ]

A | ] | g | Gy pl | = | 3 Q Dimensione Sport on Internet,.,

': 4: 2 E %’ : Aevailable Checksum.

Setial Protocols Information

| CRP Info.,.

System information

Genius setting, .. %

about, ..

This option allows to check all the features and contracts enabled on Genius. Bottom left there is one
of the most important data it is always required by the Technical Support: GOS Version (Genius
Operative System).

Genius configurations enabled

GENIUS configuration
List of the features and contracts enabled on GEMILS,

Description Expiration date
Features
Festures BIKE
Festures TIR
Festures LCW
Contract AUTO FREE F1M 2007
Contract LCY FREE F1M 2007
Cortract TIR FREE MM 2007

GOS version: 3.088

Serial Protocols Information  button allows to check out all the serial protocols enabled.

: Flle  Wiew Emulator Tools  Genius Update Jjg_lg__]
=i, | &3 | & e | G, a1l | | e W w¥ Dimensione Sport on Internet...
T EETT N

[#  Avallable Checksum. ..

|j"m] Serial Protocols Information %

CRP Info...

Syskem infarmation

Genius setting. ..

Ahout, .
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List of enabled serial protocols classified by car and protocol:

protocols written in normal are enabled on Race, those written in bold are enabled on Genius.

With the button Features it is possible to verify the serials contract.

| i Information about Seial Protocols x| : 2]
fqm Serial Protocols fqm Serial Protocols

List of available serial protocols. Protocols on gray are not available. List of available serial protocols, Protocols on gray are not available.

Code Description A|C|M| T| Genius | Race a Code Description AlC Genius | Race a
FLASH_D0O1 FLAZH_0001 FIAT BOS | v W FLAZH_DO01 FLAZH_0001 FIAT BOS | v i3
FLASH_0002 FLASH_0002 BMW SIE | " ¥ i FLASH_0002 FLASH_0002 BMW SIE | " FRE &
FLASH_0003 FLASH_0003 BMW SIE | i o FLASH_0003 FLASH_0003 BMW SIE | R &
FLASH_0004 FLASH_0004 BMW SIE | i i FLASH_0004 FLASH_0004 BMW SIE | R L3
FLASH_0005 FLASH_0005 BMW BO | T o FLASH_0005 FLASH_0005 BMW BO | FREE TRE
FLASH_0009 FLASH_0009 MIHI SIE | I 'l FLASH_0009 FLASH_0009 MIHI SIE | FREC FREE
FLASH_0010 FLASH_0010 ROVER B |~ ¥ v FLASH_0010 FLASH_0010 ROVER B |~ FRE &
FLASH_0011 FLASH_0011 MERCEDE o v ' FLASH_0011 FLASH_0011 MERCEDE o &
FLASH_0012 FLASH_0012 MERCED | | id I FLASH_0012 FLASH_0012 MERCED | | R FE
FLASH_0013 FLASH_0013 REHAUL | | v v FLASH_0013 FLASH_0013 REHAUL | | FRE RE
FLASH_0014 FLASH_0014 HYUHDAI | |~ T v FLASH_0014 FLASH_0014 HYUHDAI | |~ FREE RE
FLASH_0015 FLASH_0015 VAG TDI | v |~ L s FLASH_0015 FLASH_0015 VAG TDI | v |~ FRE RE
FLASH_0016 FLASH_D016 VAG TDI |+ |~ v s FLASH_0016 FLASH_D016 VAG TDI |+ |~ FRE FE
FLASH_0017 FLASH_00MT VAG TDI | i 'l FLASH_0017 FLASH_00MT VAG TDI | R &
FLASH_0018 FLASH_0013 FIAT BO | i i FLASH_0018 FLASH_0013 FIAT BO | R L3
FLASH_0019 FLASH_0019 CHRYSL | % v FLASH_0019 FLASH_0019 CHRYSL | i i
FLASH_0020 FLASH_0020 HISSAH |/ |/ i i FLASH_0020 FLASH_0020 HISSAH |/ |/ o i
FLASH_0021 FLASH_0021 FIAT BO |y v v FLASH_0021 FLASH_0021 FIAT BO | [ &
FLASH_0022 FLASH_0022 FIAT BO |y v v =] FLASH_0022 FLASH_0022 FIAT BO | |/ i i |

Information. . . Il\ Features.., Infaormation. . . | Features.£ I

Once selected the Serial Protocol with the button Information u can see all the information about the

selected protocol for Genius and Race: protocol version — enabled for — communication line

Protocol Information

Protocol code
FLASH_0O014

FLASH_0014 HYUNDAI C

RDI BOSCH EDE15CT

3 s o
[ aEeras o atorT /

Version  3.007

o | EEJ

Creation date
14/12/2006
modify dake

14/12/2006

Cp et ki
SETL AL IUATTRaLiJey

Version Z2.004
A | Lw
e —;w
L= | Wl
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T.TOTAL — P:PARTIAL - /: NOT POSSIBLE
ID GENIUS Description READ | WRIT K Line | CAN [J1855 | Wires

FLASH_0001 FIAT BOSCH ME 1.5.5 FAL / T X 8
FLASH_0002 BMW SIEMENS MS41 P P X 5
FLASH_0003 BMW SIEMENS MS42 P P X 5
FLASH_0004 BMW SIEMENS MS43 P P X 5
FLASH_0005 BMW BOSCH DDE4.0 P P X 5
FLASH_0009 MINI SIEMENS EMS2 P P X 1
FLASH_0010 ROVER BOSCH DDE4.0 P P X 1
FLASH_0012 MERCEDES BOSCH EDC 15C6 T T X 6
FLASH_0013 RENAULT DCI BOSCH EDC 15C2 T T X 1
FLASH_0014 HYUNDAI/KIA CRDI BOSCH EDC 15C7 T T X 1
FLASH_0015 VAG TDI BOSCH EDC15VM+19 T T X 2
FLASH_0016 VAG TDI BOSCH EDC15VM+25 T T X 2
FLASH_0017 VAG TDI BOSCH EDC15P+ T T X 2
FLASH_0018 FIAT BOSCH ME73H4/21/31/731 FAL T T X 9
FLASH_0019 CHRYSLER/JEEP CRD BOSCH EDC15C2 T T X 1
FLASH_0020 NISSAN TDDI BOSCH EDC15C2 T T X 1
FLASH_0021 FIAT BOSCH EDC15C5 FAL T T X 7
FLASH_0022 FIAT BOSCH EDC15C6/C7 FAL T T X 1
FLASH_0023 MERCEDES BOSCH CDI EDC15C5 EURO2 T T X 6
FLASH_0024 MCC SMART BOSCH EDC15C5 T T X 1
FLASH_0025 MCC SMART BOSCH MEG1.0/1.1 / T X 1
FLASH_0026 OPEL/SAAB BOSCH EDC15M / T X 1
FLASH_0027 BMW 320D DDE3.0 136CV P P X 1
FLASH_0028 VAG ME7.X 4Mbit T T X 1
FLASH_0029 VAG ME7.X 8Mbit T T X 1
FLASH_0030 VAG TDI BOSCH EDC15VM+25 8Mb T T X 2
FLASH_0031 OPEL DTI 17 DELPHI T T X 1
FLASH_0033 BMW BOSCH DME7.1 P P X 1
FLASH_0034 FAL MAGNETI MARELLI 4AF/59F/SAF/SNF T P X 1
FLASH_0035 RENAULT SIEMENS SIRIUS 32/34 P P X 1
FLASH_0038 PSA HDI BOSCH EDC15C2 T T X 1
FLASH_0041 MERCEDES BOSCH ME2.8 / T X 1
FLASH_0047 LAND ROVER TD5 MEMS NNN PSOP 29F200BT P P X 1
FLASH_0048 PORSCHE ME7.2 T T X 1
FLASH_0049 HONDA 1.7 CDTI BOSCH EDC15C7 T T X 1
FLASH_0050 BMW BOSH EDC16 C31 P P X 1
FLASH_0052 TOYOTA YARIS D-4D EDC 15C9 29F400BT T T X 1
FLASH_0053 PORSCHE BOSCH ME7.8 P P X 1
FLASH_0054 HUNDAY/KIA CRDI 2900 DELPHI P P X 1
FLASH_0055 RENAULT/NISSAN 1500 DCI DELPHI P P X 1
FLASH_0056 FIAT-ALFA-LANCIA JTD BOSCH EDC16 T T X 1
FLASH_0057 RENAULT/DACIA/NISSAN DELPHI DCM1.2 P P X X 1
FLASH_0061 FIAT/LANCIA MARELLI MJT 1300 P P X 1
FLASH_0062 PSA BOSCH ME7.4.4 P P X 1
FLASH_0064 BMW BOSCH EDC16+ C35 P P X X 1
FLASH_0067 SUZUKI-OPEL MAGNETI MARELLI MJT 1300 P P X 1
FLASH_0068 VAG BOSCH EDC16 U/2.1 T T X X 1
FLASH_0070 PSA BOSCH EDC16 C0/C3 P P X 1
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ID GENIUS Description READ | WRIT | KLine | CAN |J1855 | wires
FLASH_0071* RENAULT BOSCH EDC16 C0/C3 P P X 1
FLASH_0072 VAG EDC16+ U31/U34 P P X X 1
FLASH_0073 VAG EDC16+ CP34 P P X X 1
FLASH_0074 MEB BOSCH EDC16 T T X 1
FLASH_0075 PSA BOSCH EDC16+ CP34 P P X X 1
FLASH_0076 FAL BOSCH EDC16+ P P X X 4
FLASH_0077 KIA/HYUNDAI BOSCH EDC16+ P P X 1
FLASH_0078 CHRYSLER BOSCH EDC16 T T X 1
FLASH_0080 PORSCHE BOSCH M5.2.2 P P X 3
FLASH_0081 MERCEDES BOSCH EDC16+ CP32 P P X 1
FLASH_0082 VAG ME7.1.1 CAN T T X 1
FLASH_0084 RENAULT SAGEM 3000 P P X X 1
FLASH_0086 SUZUKI BOSCH EDC16 C0/C3 P P X 1
FLASH_0087 VAG BOSCH ME9.5 FSI T T X 1
FLASH_0088 CHRYSLER BOSCH EDC16+ P P X 1
FLASH_0089 MERCEDES 3.0 CDI BOSCH EDC16+ CP31 P P X X 1
FLASH_OOQO* OPEL BOSCH EDC16C39 / T X 1
FLASH_0091 VAG BOSCH ME9.1TFSI T T X 1
FLASH_0093 VOLVO BOSCH EDC16+ C31-6 P P X 4
FLASH_0094 LAND ROVER SIEMENS SID 201/204 / P X 1
FLASH_0095 FAL MARELLI MJD6F3 MPC563 T T X 1
FLASH_0095F FAL MARELLI MJD6F3 MPC563 / T X 1
FLASH_0097 FORD BOSCH EDC16+ C34 P P X 1
FLASH_0100 RENAULT SIEMENS SID 301 P P X 1
FLASH_0104 OPEL MARELLI+60203D T T X 1
FLASH_0105 RENAULT BOSCH EDC16+C36 P P X 1
FLASH_0106 PSA SIEMENS SID803/803A/201 / T X X 1
FLASH_0107 VAG BOSCH ME9.1.1 FSI T T X X 1
FLASH_0108 FAL MAGNET| MARELLI 4SF P P X 1
FLASH_0109 SSANGYONG DELPHI DCM T T X 1
FLASH_0111 PSA BOSCH ME 7.4.5 P P X X 1
FLASH_0112 SUZUKI DELPHI DCM1.2 P P X 1
FLASH_0113 OPEL MERIVA DTI DELPHI T T X 1
FLASH_0120 MERCEDES SIEMENS 5WK9 SIM4LE P P X 1
FLASH_0122 REANAULT MARELLI 5NR T T X 1
FLASH_0123 VAG SIEMENS PPD1.XX P P X X 1
FLASH_0124 SSANGYONG DELPHI DCM3.2 T T X 1
FLASH_0126 CHEVROLET BOSCH EDC16+ C39 P P X 1
FLASH_0127 OPEL BOSCH EDC16+ C39 P P X X 1
FLASH_0129 FAL BOSCH ME7.9.10 / T X X 1
FLASH_0130 SAAB BOSCH EDC16+ C39 P P X X 1
FLASH_0132 PORSCHE BOSCH ME7.8 MY>06/2004 / T X 1
FLASH_0133 MCCSMART/MITSUBISHICOLT BOSCH EDC16+C31 | P P X X 1
FLASH_0134 MCCSMART FORTWO BOSCH EDC16+ CP32 / T X 1
FLASH_0135 FO.MO.CO. VISTEON FORD/LASND ROVER P P X 1
FLASH_0136 FAL BOSCH ME7.6.1 [ ** T X 1
FLASH_0137 FAL BOSCH ME7.6.2 [ ** T X 1
FLASH_0139 VAG BOSCH EDC16U/2.1 V10 M&S T T X 1

Dimensione Sport sr.l.

37



D.Eﬂrrkomcn e i 9y AGNEDNELBSOK 04th AUGUST 2008

IDGENIUS | Description READ | WRIT | KLine | cAN | 31855 | wires
FLASH_0140 VAG BOSCH EDC16+U31/U34 V10 M&S P P X 1
FLASH_0141 HONDA BOSCH EDC16C1-7 T T X 1
FLASH_0144 NISSAN QASHQAI BOSCH EDC16+ CP33 P P X 1
FLASH_0145 VAG BOSCH ME9.1.1 FSI V8/\V10 M&S T T X 1
FLASH_0149 MERCEDES SIEMENS SIM4LKE P P X 1
FLASH_0150 PSA BOSCH EDC16+ CP39 P P X 1
FLASH_0151 RENAULT SIM32 P P X 1
FLASH_0152 FORD BOSCH EDC16C3 T T X 1
FLASH_0153 DODGE/JEEP/MITSUBISHI BOSCH EDC16+ U31 T T X 1
FLASH_0154 LAND ROVER FREELANDER BOSCH EDC16+ CP39| P P X 1
FLASH_0155 FORD SIEMENS SID803A/SID202 P P X 1
FLASH_0156 FORD SIEMENS SID206 P P X 1
FLASH_0157 FORD SIEMENS SID803 T T X 1
FLASH_0158 FORD SIEMENS SID804 T T X 1
*for a correct use of this protocol please checka  ppendix “B”

** jt could be necessary to read with Trasdata tool
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15 WIRING LIST

Details of the wiring components are at Pag. 4-5-6-7-8 Chpt.3
WIRING 1:
1. CABLE OBD Il K-CANBUS- J1850 (Rif.2)

WIRING 2:
1. CABLE OBD Il K-CANBUS- J1850 (Rif.2)
Connecting directly to the ECU:
Cables 2008
1. CONNECTOR FOR ECU V.A.G (Rif.21)

Old cables

ADAPTOR FOR FLASH4 WIRING SYSTEM (Rif.4)
CONNECTOR FOR ECU V.A.G (Rif.13)
BATTERY CABLE (Rif.11)

PSU 12 volt (Rif.10)

PwnNhpE

WIRING 3:
Cables 2008
1. CABLE OBDIlI FOR PORSCHE M5.2.2 (Rif.20)

Old cables
1. ADAPTOR FOR FLASH4 WIRING SYSTEM (Rif.4)
2. CABLE OBDII FOR PORSCHE M5.2.2 (Rif.12)

WIRING 4:
1. CABLE OBD Il K-CANBUS- J1850 (Rif.2)
Cables 2008

1. UNIVERSAL WIRING FOR SERIAL PROGRAMMING (Rif.7)

Old cables
1. ADAPTOR FOR FLASH4 WIRING SYSTEM (Rif.4)
2. UNIVERSAL WIRING FOR SERIAL PROGRAMMING (old cable with K-line only)

WIRING 5:
1. CABLE OBD Il K-CANBUS- J1850 (Rif.2)
1. ADAPTOR FOR FLASH4 WIRING SYSTEM (Rif.4)
2. PLUG CABLE RJ45 (Rif.14)
3. BMW DIAGNOSTIC CONNECTOR (Rif.14)

WIRING 6:
1. CABLE OBD Il K-CANBUS- J1850 (Rif.2)
Cables 2008

2. MERCEDES DIAGNOSTIC CONNECTOR CABLE (Rif.22)
Old cables

3. ADAPTOR FOR FLASH4 WIRING SYSTEM (Rif.4)
4. MERCEDES DIAGNOSTIC CONNECTOR (Rif.15)
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WIRING 7:

1.

1.

wn

PoONPE

CABLE OBD Il K-CANBUS- J1850 (Rif.2)
Cables 2008

FIAT ALFA LANCIA DIAGNOSTIC CONNECTOR FOR SERIAL COMMUNICATION (Rif.23)
RED WIRE +12V
BLACK WIRE GND

Old cables
ADAPTOR FOR FLASH4 WIRING SYSTEM (Rif.4)
FIAT ALFA LANCIA DIAGNOSTIC CONNECTOR FOR SERIAL COMMUNICATION (Rif.16)
RED WIRE +12V
BLACK WIRE GND

WIRING 8:

1.
2.

wnN =

PONPE

CABLE OBD Il K-CANBUS- J1850 (Rif.2)
BLUE WIRE

Cables 2008

FIAT ALFA LANCIA DIAGNOSTIC CONNECTOR FOR SERIAL COMMUNICATION (Rif.23)
RED WIRE +12V

BLUE WIRE

Old cables

ADAPTOR FOR FLASH4 WIRING SYSTEM (Rif.4)

FIAT ALFA LANCIA DIAGNOSTIC CONNECTOR FOR SERIAL COMMUNICATION (Rif.16)
RED WIRE +12V

BLUE WIRE

WIRING 9:

PoONPE

Ok whE

Cables 2008

CABLES A FOR BOSCH ME7.3.1, ME3.1, ME2.1, ME7.3H4 HYBRID ECU (Rif.24)
CABLES B FOR BOSCH ME7.3.1, ME3.1, ME2.1, ME7.3H4 HYBRID ECU (RIif.25)
BATTERY CABLE (Rif.11)

PSU 12 volt (Rif.10)

Old cables

ADAPTOR FOR FLASH4 WIRING SYSTEM (Rif.4)

CABLES A FOR BOSCH ME7.3.1, ME3.1, ME2.1, ME7.3H4 HYBRID ECU (RIif.17)
CABLES B FOR BOSCH ME7.3.1, ME3.1, ME2.1, ME7.3H4 HYBRID ECU (RIif.18)
BATTERY CABLE (Rif.11)

PSU 12 volt (Rif.10)
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WIRINGS COMPONENTS

WIRING 1:

WIRING 2:

This kind of ECU requires the OBDII connection, onl vy in few cases there is no communication
between OBDII and ECU.

If there is not any possibility to connect through OBDII socket because there is not any kind of
communication with the ECU the only way to communic ate is through CONNECTOR FOR ECU V.A.G.
(Old cable Rif.13 or cable 2008 Rif.21)

CAUTION: if it will be necessary to remove the ECU you can use the following wiring:
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must switch

When the software RaceEVO\
shows you the message
Switch ON the dashboard you

than when the system ask you
to switch OFF the dashboard
you must switch another time
the red botton.

the red botton ,

If you want you
can obtain
supply from
+12V battery
using the battery
connectors

If you want you
can obtain
supply from
+12V battery
using the battery
connectors

\Ghen the software RaceEVO\

shows you the message
Switch ON the dashboard you
must switch the red botton ,
than when the system ask you
to switch OFF the dashboard
you must switch another time

the red botton. /

CAUTION: After any Read/Write operation with this w
to delete eventual errors inside the ECU (Airbag |
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WIRING 3:
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Cables 2008

WIRING 4:

If there is not any communication with the

ECU through OBDII socket the only way to
communicate is through universal wiring as
explained below.

Or
(see next page)
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Cables 2008
(ATTENTION for this wiring see Appendix A)

7

Old cables

(ATTENTION for this wiring see Appendix A)

WIRING 5:

For this wiring you could

typical BMW load
connector

find an OBDII socket or a
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Cables 2008

Old cables

(See next page)
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For this wiring you could
find an OBDII socket or a
typical Mercedes
diagnosis connector

For this kind of connection you
could find an OBDII socket or
a typical FIAT/ALFA/LANCIA
diagnosis connector
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Cables 2008
23 - /

Old cables

Connect to car
battery +12V
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Connect to car
battery +12V

Connect to GND

16

Connect to GND
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WIRING 8:

This wiring is made up of connectors for serial Reading/Writing procedure and additional connectors that
allow you to communicate with particular ECU.

So we have two different type of wiring:

Wiring 8.1 (With OBDII connector)

Fae dl proganmmonrisac
peticce &l plo 13

CAUTION: We must put one endpoint of the blue wire in the OBDII blue connector, the other one must be
connected to the Pin 10 of the ECU.

Or

Wiring 8.2 (With FIAT-ALFA-LANCIA connector)

Cables 2008

Tl programmarkess 7
weee &l pin 11 bhs

Connect to car
battery +12V
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Old cables

{ona dl proganmmoniere
i copeeticee 5l pla 11

Connect to car
battery +12V

CAUTION: one endpoint of the blue wire must be connected to FIAT/ALFA/LANCIA blue connector, the
other one must be connected to the Pin 10 of the ECU, for what concern the red wire, one endpoint must be
connected to the +12V battery connector and the other one to the FIAT/ALFA/LANCIA red connector

WIRING 9:

CAUTION: for this wiring it's necessary to remove the ECU, you can work using the following wiring (SINGLE
or DOUBLE)

Wiring 9.1 ( Single without blue wire)
Cables 2008

G you want you \

can obtain
supply from
+12V battery
using the battery
connectors
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/If you want you
can obtain
supply from
+12V battery
using the battery
connectors

-

Wiring 9.2 ( Double with blue wire)

Cables 2008

m

Old cables

If you want you
can obtain
supply from
+12V battery
using the battery
connectors
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CAUTION: in order to select the right wiring ( SINGLE or DOUBLE) please read the following indications:

Reprogramming through direct connection to the ECU
The connection to the ECU is direct and it is obtained using the suitable cable, double or single connector,
with the white adapter RJ45, the supply power is obtained directly through the battery or from the electrical

network.Cables are divided into two main families:

SINGLE TYPE CABLE (WITHOUT BLUE WIRE):
supplied with a crocodile-clipped black wire that must
be connected to the ground pin of the ECU (aluminium

box).

We consider “single type” all the ECU with both
reading and writing pins on a single connector. In

order to identify a single type we must find

numbers printed on the ECU. If the numbers are 253
and 254, only the right connector MUST BE USED

(Marked with RED lines) .

Make sure that pins 15, 32, 48 are communicating

between them by using a digital multimeter!

DS (1))

951212 1037352237 (51D
8 261 284 983

00465228780

the

DOUBLE TYPE CONNECTOR (with external BLUE
WIRE):

supplied with a crocodile-clipped black wire that must be
connected to the ground pin of the ECU (aluminium box)
and an additional female pin-ending BLUE wire that must
be plugged to the LEFT connector located on the ECU
(other available connector).

We consider “double type” all the ECU with serial reading
and writing pins on both connectors. As for the single type
connector, power supply pins and diagnosis pins are
located on the right connector, whereas the pin which
enables the communication is located on the left
connector (marked in BLUE). The identification numbers
for this kind of ECU are 314 and 313.

For this kind of ECU, the double type connector must be
plugged into the RIGHT CONNECTOR and the blue wire,
which extends it self from the cable, must be connect to
the PIN 20 in the LEFT CONNECTOR.

CAUTION : For some ECU, as the ME7.3.1 the position
of the original connector does not correspond to the
position of the FLASH0018 cable. Do not force the
FLASHO0018 cable into the ECU connector if the position

isn't correct. On the contrary for ME3.1 and ME7.3H4 the position of the original connector and the position

of the FLASH0018 cable correspond.

Make sure that pins 17, 33, 49 in the right connector are communicating between them by using a digital

millimetre.
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APPENDIX A (Special Applications)

FLASH 0076 (FAL BOSCH EDC16+)

A direct connection between OBDII socket and ECU is not possibile because there is no K-line.

To solve this problem it is necessary to connect directly to the PIN 25 in the ECU. You have to lift up the
connector then, by using the universal cable, you have to connect the K-line of the universal cable (yellow
wire) with one end of the blue connection wire. Then link the second end of the same blue connection wire to
PIN 25 of the ECU.

Old Cables Or Cables 2008

To create the connection we have chosen to connect the K-line (yellow wire of the universal cable) to PIN 43
using the blue wire, after we have connected with the clamps the red wire to the positive pole of the battery
(+12V) and the black wire to ground (GND).

Dimensione Sport sr.l. 51




= - .. ®
HANDBOOK

FLASH_ 0093 (VOLVO BOSCH EDC16+ C31-6)

In Volvo cars that have ECU Bosch EDC16+ C31-6 the communication between PIN 7 of OBD Il and PIN 43
of ECU is missing.

It is necessary to connect Genius with the connectors of the ECU following the instructions:

1 — Unplug the little connector of the ECU and dismantle warily the plastic protection as in the pictures

2 — In the connector look for the PIN 43 that alllows the communication with the ECU.

To create the communication we decided to connect the K-Line (yellow wire) of the universal wiring (Rif.7) to
the PIN 43 using the blu wire as in the pictures below, then we have connected the red wire to the positive
pole of the battery (+12V) and the black one to ground (GND) using little clamps.

Old cable

or cable 2008
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APPENDIX B (Specific Procedures)

FLASH_0071 (RENAULT BOSCH EDC16 C0/C3)

FLASH_0071protocol for ECU Reanault Bosch EDC16 C0/C3 has been studied to solve the problem with
the injectors codification.
To work properly and manage a correct modification on ECU Reanault Bosch EDC16 CO/C3 it is
obbligatory to make the serial operations (reading and writing in ECU) with cold engine _and itis
necessary to follow the sugested procedure
1 — after connecting Genius to OBDII socket the first operation to do is the reading of injectors code:
open the protocol FLASH_0071 in this way
Work—>Vehicles>select the correct vehicle otherwise
Work—> Protocols—> select the protocol FLASH_0071
Select the button CODING and continue with the READING of the code

2 — A window will show the Informations of the, continue with the reading. Then you will have to save the
code file with name.

3 — after reading the injectors code it is possibile to read the whole file of ECU, export i tinto Race EVO and
manage the modifications.
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4 — After the modifications you have to export the mod file from Race EVO into Genius in order to write in the

ECU. Follow the procedure for serial writing as described at pa. 13 Chp. 9.3
When you choose the correct .mod file to write a message will appear:

N.B.

It is necessary to read the injectors codes before writing procedure, If you do not have read out the injector
codes you MUST do it right now aborting the procedure of writing and following the instructions at pg.39

If you have already read the injectors codes click on Continue.

5 —When the Writing procedure is started follow the messages of switching ON/OFF as required.
Genius will automatically read the injectors codes setting it in RAM memory, then it will proceed with the

writing of .mod file until a message will appear:

Select Continue and Genius will proceed with writing back the injectors codes file.

At the end of writing will appear this message:

Dimensione Sport sir.l.
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ATTENTION

If there are interruptions of communication during writing procedure, or something that blocks the correct
automatic writing procedure of injectors codes and the car does not start it will be necessary a manual
writing procedure of injectors codes. For this operation please read the following procedure:

1 — open protocol FLASH_0071 in this way
Work—>Vehicles>select the correct car otherwise
Work—> Protocols—> select the protocol FLASH_0071

Select the button CODING and run the WRITING procedure of codes

Now select the correct injectors codes file saved before inside the folder COD, if you are not sure of what file
choose please check the chassis number witten in the Information window.
To proceed please click on Continue.

After the end of writing injectors codes procedure Genius will display this message.
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FLASH_0090 (OPEL BOSCH EDC16C39)

FLASH_0090 protocol for ECU Opel Bosch EDC16C39 cannot read the file inside the ECU but it has been
studied to run a verify between the file inside ECU and the original file present in the corresponding setting
file.

It is necessary follow the procedure:

1 - make ldentification and with the ECU numbers search for the corresponding setting file in data bank.

2 - download the correct setting file in Race EVO, then export the .ORI file on Genius

3 - after connecting Genius to OBD Il socket enter into the menu of the FLASH_0090 protocol in this way:
Work->Manufacturer->Model>Type—> select the corect vehicle oppure
Work—> Protocols—> select the protocol FLASH_0090

4 - once entered in the menu protocol it is necessary to select the button Verification.
In the next window you have to select the file .ORI that you saved before in the folder Write, click on the
button Continue to run the Verification between the two files.
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5 - now a sequence of messages will ask you to switch on and off the dash-board, follow the instructions
and the requests clicking on the button Continue until it will join the end of the verification.
If Verification is OK Genius will ask to execute the modification starting from the selected .ORl file.
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APPENDIX C — VAG COUNTER RESET

VAG COUNTER RESET is an optional feature not included in any contract, in order to have it please contact
directly the commercial department.

Select TOOL > SPECIAL > COUNTER

READING

The first time you want to work with counters wuo will have to READ and WRITE a part of the FLASH and of
the MICROPROCESSOR.At the end of the reading save this file in Genius. The reading mode starts only if
the PATCH FILE is NOT found in the ECU.
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If the PATCH FILE is already present in the ECU you can directly modify the counter by clicking on
READING button.

FIRST WRITING

In order to modify the counter the first time you have to program the ECU with the PATCH FILE. Select the
file read, correct the value for succeded writings and press OK. ATTEMPTED counter will be automatically
aligned with SUCCEDED.
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